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Video shooting tips 
With a camcorder of choice in hand, it’s time to venture off and shoot videos. This guide presents a collection of tips 
and some specialized advice from a TV news chief photographer. 


Get a closing shot 
Your closing images stick in people’s minds. Be constantly on the lookout for that one shot or sequence that  wraps 
up your story effectively. It could be as simple as someone closing a door, capping a pen, petting a dog, turning out 
the lights, or releasing a butterfly from cupped hands. 


Get an establishing shot 
An establishing shot sets the scene in one image (Figure 1). Although super-wide shots work well (aerials in 
particular), consider other points of view: a race seen from the cockpit, a close-up of a scalpel with light glinting off 
its surface, paddles dipping frantically in roaring white water. Your picture should grab the viewer’s attention and 
help set up your story. 


 
Figure 1 An establishing shot (left) sets the scene and the second shot tells the story. 


Shoot plenty of video 
Videotape is cheap and expendable. Shoot more raw footage than you’ll put in your final production. Five times as 
much is not unusual. Giving yourself that latitude helps you grab shots you would have missed otherwise. 
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Adhere to the rule of thirds 
It’s called the rule of thirds, but it’s more like the rule of four intersecting lines (Figure 2). When composing your 
shot, think of your viewfinder as crisscrossed by two horizontal and two vertical lines. The center of interest should 
fall along those lines or near one of the four intersections, not in the center of the image. 


Another way to follow the rule of thirds is to look around the viewfinder as you shoot instead of staring at its center. 
Check the edges to see whether you’re filling the frame with interesting images. Avoid large areas of blank space. 


 
Figure 2 The rule of thirds 


Keep your shots steady 
You want to give viewers the sense that they’re looking through a window or, better yet, right there on location. A 
shaky camera shatters that illusion. 


When possible, use a tripod. The best ones have fluid heads so you can make smooth pans or tilts. 


If a tripod is impractical, try to find some way to stabilize the shot: lean against a wall, put your elbows on a table, or 
place the camcorder on a solid object. 


Follow action 
This might seem obvious, but keep your viewfinder on the ball (or sprinter, speeding police car, surfer, conveyor 
belt). Your viewers’ eyes will want to follow the action, so give them what they want. 


One nifty trick is to use directed movement as a pan motivator. That is, follow a leaf’s progress as it floats down a 
stream and then continue your camera motion past the leaf—panning—and widen out to show something 
unexpected: a waterfall, a huge industrial complex, some people fishing. 


Use trucking shots 
Trucking or dolly shots move with the action. For example, hold the camera at arm’s length right behind a toddler 
motoring around the house, put the camera in a grocery cart winding through the aisles, or shoot out the window of a 
speeding train. 


Find unusual angles 
Get your camcorder off your shoulder, away from eye level, for more interesting and enjoyable shots. Floor-level 
shots are great for children and pets. Shoot up from a low angle and down from a high angle. Shoot through objects 
or people while keeping the focus on your subject. 
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Lean forward or backward 
Don’t use the zoom lens as a crutch. A better way to move in close or out away from a subject is literally to lean in 
or out. For example, start by leaning way in with a tight shot of a woodcarver’s hands. Then, while still recording, 
lean way back (perhaps widening your zoom lens as well) to reveal that the carver is working in a sweatshop full of 
folks hunched over their handiwork. 


Get wide shots and tight shots 
Our eyes work like medium-angle lenses, so we tend to shoot video that way. Instead, grab wide shots and tight 
shots of your subjects (Figure 3). If practical, get close to your subject for the tight shot rather than using the zoom 
lens. Your shot will look better and the proximity will give you clearer audio. 


 
Figure 3 Wide shots and tight shots 


Shoot matched action 
Consider a shot from behind a pitcher throwing a fastball. The pitcher releases the ball and then it smacks into the 
catcher’s glove. Instead of a single shot, grab three shots: a medium shot from behind the pitcher making the pitch, a 
shot from behind the catcher of the ball in flight, and a tight shot of the catcher’s glove. Use the same concept for an 
artist: get a wide shot as the artist applies a stroke to the canvas and then move in for a close shot of the same action. 
You’ll edit them together to match the action (Figure 4). 


 
Figure 4 Matched action shots 


Get sequences 
Shooting repetitive action in sequence is another way to tell a story, build interest, or create suspense. A bowler 
wipes his hands on a rosin bag, dries them over a blower, wipes the ball with a towel, picks up the ball, fixes his 
gaze on the pins, steps forward, swings the ball back, releases it, slides to the foul line, watches the ball’s trajectory, 
and then reacts to the shot. Instead of simply capturing all this in one long shot, piece these actions together in a 
sequence of compelling edits. You can easily combine wide and tight shots, trucking moves, and matched action to 
turn repetitive material into attention-grabbing sequences. 
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Avoid fast pans and snap zooms 
These moves fall into MTV and amateur video territory. Few circumstances call for such stomach-churning 
camerawork. Minimize pans and zooms that remind viewers they’re watching TV. 


If you do zoom or pan, do it for a purpose: to reveal something, to follow someone’s gaze to the subject of interest, 
or to continue the flow of action (as in the floating leaf example). A slow zoom in, with only a minimal change to 
the focal length, can add drama to a sound bite. Again, do it sparingly. 


Note: Don’t let this no-fast-moves admonition force you to stop rolling while you zoom or pan. If you see 
something that warrants a quick close-up shot or you need to suddenly pan to grab some possibly fleeting footage, 
keep rolling. You can edit around that sudden movement later. If you stop recording to make the pan or zoom or 
adjust the focus, you might lose whatever it was you were trying so desperately to shoot. And you will miss any 
accompanying natural sound. 


Shoot cutaways 
Avoid jump cuts by shooting cutaways. A jump cut is an edit that creates a disconnect in the viewer’s mind. A 
cutaway—literally a shot that cuts away from the current shot—fixes jump cuts. 


Cutaways are common in interviews where you might want to edit together two 10-second sound bites from the 
same person, making the interviewee appear to move suddenly. To avoid that jump cut—that sudden disconcerting 
shift—make a cutaway of the interview. It could be a wide shot, a hand shot, or a reverse-angle shot of the 
interviewer over the interviewee’s shoulder. Then edit in the cutaway over the juncture of the two sound bites to 
cover the jump cut. 


The same holds true for a sports event (Figure 5). Cutting from one wide shot of players on the field to another can 
be disconcerting. If you shoot the scoreboard or some crowd reactions, you can use those cutaways to avoid jump 
cuts. 


 


 
Figure 5 A crowd reaction shot works well as a cutaway from this bloodless bullfight in Sumatra. 
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Don’t break the plane 
Breaking the plane causes another viewer disconnect. If you’re shooting in one direction, you don’t want your next 
shot to be looking back at your previous camera location (Figure 6). For instance, if you’re shooting an interview 
with the camera peering over the left shoulder of the interviewer, shoot your reverse cutaways over the interviewee’s 
right shoulder. That keeps the camera on the same side of the plane—an imaginary vertical wall running through the 
interviewer and interviewee. 


To shoot over your interviewee’s left shoulder would break that plane, meaning viewers would expect to see the 
camera that took the previous shot. 


 
Figure 6 The plane is an imaginary vertical wall running, in this case, through the interviewer and interviewee. 


In general, you want to keep all your camera positions on one side of the plane, even when shooting large-scale 
events such as football games. Although viewers won’t expect to see another camera (consciously or 
unconsciously), they might lose track of the direction of play. 


There are exceptions. When videotaping a rock group performance, for example, camera crewmembers typically 
scramble all over the stage, grabbing shots from multiple angles and even appearing on camera themselves. 


Note: If you conduct formal, sit-down interviews with more than one person for the same piece, consider shooting 
each subject from a different side of the interviewer. Shoot one subject with the camera positioned over the 
interviewer’s left shoulder. For the next interview, move the camera behind the interviewer’s right shoulder. This 
avoids a subtle jump cut that happens when you edit bites from two individuals who are facing the same direction. 
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Use lights 
Lights add brilliance, dazzle, and depth to otherwise bland, flat scenes. Consider using an onboard camcorder fill 
light and—if you have the time, money, patience, or personnel—a full lighting kit with a few colored gels. In a 
pinch, be creative about increasing available light. Open curtains, turn on all the lights, bring some desk lamps into 
the room. One caveat: Low-light situations can be dramatic, and flipping on a few desk lamps can destroy that mood 
in a moment. 


Grab good bites 
Your narrator presents the facts. The people in your story present the emotions, feelings, and opinions. Don’t rely on 
interview sound bites to tell who, what, where, when, and how. Let those bites explain the why. 


For example, your narrator should be the one to say “It was opening night and this was her first solo.” Let the singer, 
recalling this dramatic moment, say, “My throat was tight and my stomach was tied in knots.” 


Although your interviews might be lengthy, use only short sound bites in your final production. The bites should be 
punctuation marks, not paragraphs. 


Note: Make exceptions for idiosyncratic characters. Some characters you’ll videotape are so compelling, quirky, or 
humorous that your best bet is to let them do the primary narrating. Then consider scenes you can use to illustrate 
their commentary so you don’t fill your entire video with a talking head. 


Get plenty of natural sound 
Think beyond images. Sound is tremendously important. Listen for sounds you can use in your project. Even if the 
video quality is mediocre, grab that audio. Your camcorder’s onboard mic is not much more than a fallback. 
Consider using additional mics: shotgun mics to narrow the focus of your sound and avoid extraneous noise, 
lavalieres tucked out of sight for interviews, and wireless mics when your camera can’t be close enough to get just 
what you need. 


Stripe your tapes 
Adobe Premiere Pro can automate much of the video capture process. But if your digital videotape has a gap in its 
timecode, automated capture might not work. 


Gaps typically occur when you eject a partially recorded tape and then reinsert it, resetting the timecode to zero and 
leaving an unrecorded portion on the tape. With gaps, Premiere Pro can’t automatically capture clips you’ve logged. 


Stripe your tapes before shooting to resolve this issue. Place a fresh tape in your camcorder, cap your lens, press 
Record, and wait for your camcorder to record the entire tape. This lays down continuous timecode from beginning 
to end and avoids duplicate timecodes or breaks in the timecode on the tape. 


Rewind the tape and you’re ready to go. Now, as you use your camcorder, new video is recorded over the black 
video you recorded, but the timecode doesn’t change. 


Plan your shoot 
When you consider a video project, plan what you need to shoot to tell the story. How long will it be, how many 
shots will you need, who will you interview, what kind of mics and lights will you use, and how will you control the 
environment. Or will you need to respond to changing circumstances? Sporting events and concerts have a rhythm 
and flow that allow for detailed planning. A student anti-war protest can shift directions with no warning, requiring 
you to quickly change your tactics. 


In any event, no matter how you envision the finished project, be willing to make changes as the situation warrants. 
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Selecting and connecting microphones 
Most camcorders have onboard mics. Onboard mics pick up sound from everywhere, including wind, the zoom lens 
motor, the hum of overhead fluorescent lights, and any noises made while handling the camcorder. To capture 
clearer audio, you might choose an external mic. Following are descriptions of the available options. 


Standard mics 
To capture clean sound, you need an external mic: a specialized mic that serves narrow but useful functions. These 
four basic types suit most circumstances: 


• Handheld 


• Shotgun 


• Lavaliere 


• Surface-mount 


Handheld mics 


Handheld mics are the workhorses of the audio industry. Because they are built with internal shock mounts to reduce 
handling noise, these mics are best for conducting an interview, recording a speech (especially at a podium), and 
creating a narration. 


Many handheld mics are omnidirectional, meaning they pick up sound from all directions. They’ll pick up ambient 
room noise as well as close-up audio. To minimize unwanted noise, keep the mic as close to your subject as 
practical—usually about a foot from the speaker’s mouth. Position a handheld mic at an angle of about 45 degrees to 
cut down on breath pops when the speaker pronounces Ps and Ts. 


Shotgun mics 


A shotgun mic resembles a shotgun barrel. Shotgun mics reduce ambient noise and work well for informal, 
impromptu interviews. Instead of shoving a handheld mic in a nervous interviewee’s face, you can hold a shotgun 
mic farther away. The shotgun mic’s unidirectional barrel (called an interference tube) narrows the focus of the 
audio field to about 30 degrees. 


Shotgun mics don’t zoom. Think of them as looking through a long tube. They narrow the “view” of the sound. 


The zoom-lens equivalent in the microphone world is a parabolic dish. You’ve seen networks use them along the 
sidelines of NFL games to get those great crunching hits. 


Lavaliere mics 


When producing videos, you usually don’t want to remind viewers that they are watching TV. Lavalieres help avoid 
that. Their tiny size means you can conceal them to give viewers the feeling that the speaker is talking directly to 
them. In particular, you should use lavaliere mics for formal, sit-down interviews. The downside is that most 
lavalieres require batteries, which tend to wear out at inopportune moments. 


Surface-mount mics 


Surface-mount mics (also called boundary mics) are commonly used to pick up several speakers at a conference 
table or on a theater stage. They’re built to be placed on a flat surface and pick up sound waves both from the air and 
moving through the hard surface. 
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Wireless systems and mics 
Wireless mics open a whole new spectrum of possibilities, enabling you to record sound from a distance. After 
you’ve used one, you’ll wonder how you got along without it. Depending on the wireless system, you can hook up a 
standard mic—handheld, shotgun, or lavaliere—to a wireless transmitter or use a mic with a built-in transmitter. 


Recommended single-mic solution 
You might find you don’t have the luxury of taking a number of mics on a shoot. TV news crews often find 
themselves moving quickly from one spot to another and from one interviewee to another. What generally works 
best is a wireless shotgun mic. A shotgun mic is versatile and gives great mobility when connected to a wireless 
transmitter. You can get crystal-clear audio even though the mic might be far from your camcorder on a podium or 
in a reporter’s hands in the middle of a crowd. Interviews will be more spontaneous—the mic is less obtrusive than a 
typical handheld mic because it can be held farther from the interviewee’s face and the reporter doesn’t have to take 
a few extra moments to plug it into the camcorder. 
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Story creation tips 
Creating a video is a multistep process: planning, shooting, interviewing, writing, and editing. During each stage of 
the process, you develop your story to best reach your audience. The tips in this guide describe ways to plan, shoot, 
and capture moments to make your videos compelling. These are maxims from NBC-TV Today Show 
correspondent Bob Dotson. 


Dotson regularly presents seminars on how to create stories on video. His principal themes are: 


• Give viewers a reason to remember the story. 


• When interviewing people, try not to ask questions. Merely make observations. Making observations puts 
people at ease so they reveal their emotional and human side. 


• Be sure to get a closing shot. Most video producers look for dramatic opening shots or sequences (a good 
thing), but your viewers are more likely to remember the closing shot. 


Bob Dotson’s Storyteller’s Checklist 
Dotson prepared his Storyteller’s Checklist with TV news reporters in mind, but his tips apply to students, 
professionals, corporations, and home video producers as well. 


Video shooting and editing tips 


• Create a strong close, something you build toward throughout the story. Ideally, the ending is also visual. 


• Build your report around sequences: two or three shots of a guy buying basketball tickets, two or three shots of 
a couple drinking coffee at a kitchen table, and so on. Sequences demand matched action. 


• Use strong natural sound to heighten realism, authenticity, and believability and to heighten the viewer’s sense 
of vicarious participation in the events you’re showing. Some reports merely let the audience watch what 
happened. The best reports make it possible to experience what happened. 


• Short sound bites prove the story you are showing. Don’t use sound bites as substitutes for your storytelling. 
Present the facts and let your interviewees present the feelings. 


Writing tips 


• Always remember that the reporter (or narrator) is not the story. 


• Make sure you know what you want the audience to take away from the story. Formulate this theme to yourself 
to help guide the story creation. Then use your images to prove that theme visually. Very seldom will you state 
the theme verbally in any story. 


• Write to your pictures first. Write a strong lead that instantly telegraphs the story to come. 


• Keep the main body of the story to three to five main points, and prove them visually after you’ve identified 
them. 


• Write loose. Avoid being too wordy. Be hard on yourself as a writer. Say nothing in the script that your viewers 
would already know or that the visuals say more eloquently. 


• Allow for moments of silence. Stop writing occasionally and let two or three seconds or more of compelling 
action occur without a voiceover. For a writer, nothing is more difficult to write than silence. For viewers, 
sometimes nothing is more eloquent. 


• Build in surprises to sustain viewer involvement. Surprises help viewers feel something about the story; they 
lure uninterested viewers to the screen. Surprises can be visuals, wild sounds, short bites, or poetic script. 
Always, surprises are little moments of drama. 







Project 3 guide  


2 Story creation tips © 2008 Adobe Systems Incorporated 


• Tell your story through people. People sell your story. Try to find strong central characters engaged in 
compelling action that is visual or picturesque. 


• Address the larger issue. “A trailer home burned down” fails to meet the “so what?” test. “The trailer home 
burned down because the walls are full of flammable insulation” meets the “so what?” test because it describes 
the larger issue. 


• Finally, make your story memorable. Can your viewers feel something about the story and its subjects? If 
feeling is present, the story will be memorable. It will stick in the viewers’ minds. 


Bob Dotson—NBC-TV reporter 
Bob Dotson is one of the nation’s top network-television feature reporters. He has received more than 100 awards 
for his work in broadcast journalism, including four National Emmys. The Society of Professional Journalists cited 
Dotson for the Best Network Feature Reporting of 2004, and the Radio and Television News Directors Association 
honored him for Best Network News Writing. 
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Writing tips 
Writing for video is different from writing for print. When you write broadcast copy, you are writing for the ear. 
Your viewers can’t go back and reread something that didn’t quite make sense. To ensure they understand your 
message, follow this collection of tips from media consultant Mackie Morris and Hollywood scriptwriters Stephen 
Black and Henry Stern. 


The Good Writer’s Dazzlin’ Dozen 
Mackie Morris frequently conducts seminars for TV news stations. At those seminars, Morris relentlessly drives 
home his active-voice message. Peppered throughout his presentation are other useful writing tips. He calls them 
“The Good Writer’s Dazzlin’ Dozen”: 


• Write factually and accurately: The best technique and the finest form mean nothing if your copy is wrong. 


• Write in the active voice: This technique makes your copy tighter, more complete, easier to listen to, and more 
interesting. Do whatever you must to avoid the passive voice. 


• Write in the present tense or present perfect tense: That makes your copy more immediate, and immediacy is 
more interesting. For news stories in particular, avoid the word “today” because it becomes repetitive. If you 
use past tense, make sure you give a time reference to avoid confusion. 


• Keep your writing simple: Give the audience the best possible chance to understand your story. Choose positive 
forms over negative forms. Instead of writing “The university board rejected a proposal to close admissions,” 
say “The board kept admissions open.” Write one thought to a sentence. Don’t search for synonyms; repetition 
is not a sin. Don’t search for complicated, “intellectual” language. Avoid technical jargon. These elements 
demand extra effort from your listeners, and you might lose them. 


• Be complete and clear: In your quest for brevity and conciseness, don’t omit necessary information. 


• Stick to the rules but develop your own style: Try to say the same old thing in a different, new way. Make use 
of writing devices that make copy easier to listen to and more interesting, such as using the “rule of threes” (that 
is, grouping items by threes, such as red, white, and blue; left, right, and center; over, under, and through). 
Saying things in groups of three always sounds better. Pausing before saying the third item is even more 
effective. 


• Write to be heard: Maintain a sense of rhythm in your writing. All life has rhythm, and rhythmic writing is 
easier to hear. Mastering this concept is difficult. Start by avoiding long sentences and punctuating your copy 
with sentence fragments. In addition, avoid potentially confusing homonyms. Always test your copy by reading 
it aloud. 


• Avoid interruptives: Don’t force the listener to make difficult mental connections. Put modifiers next to what 
they modify. Don’t split verb phrases (split infinitives). 


o Incorrect: Will eventually decide. 


o Correct: Eventually will decide. 


o Incorrect: Doctors only gave him six months to live. 


o Correct: Doctors gave him only six months to live. 


• Use commas sparingly: Because you are writing to be heard, you want to avoid unnecessary breaks in your 
copy. A comma demands a hitch in reading and the resulting jerkiness frustrates the listener. Reducing the 
number of commas also eliminates subordinate clauses that kill the impact of copy, especially if they come at 
the top of a story or sentence. 


• Use numbers sparingly: Listeners have trouble remembering numbers. If you need to use numbers, try to round 
them off or reinforce them by using on-screen supers (text that identifies a location or interview subject, for 
example). 
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• Avoid ambiguous pronoun references: If you use a pronoun, make sure the pronoun agrees with its antecedent 
and appears close to the antecedent. For example, “John Doe hit Bob Smith on the head and paramedics took 
him to the hospital.” Instead of “him,” use “Smith.” 


• Let the pictures tell as much of the story as they can: Video that clearly conveys a specific message requires 
general writing, while generic video needs more detailed writing. Utilize the touch-and-go method, wherein you 
write directly to the video at the beginning of a sequence and then allow the writing to become more general 
with background information and other facts as the video continues. 


Writing in the active voice 
Writing in the active voice dramatically improves the quality of your productions. 


For example, consider this passive-voice example: 


A bill was passed by the Senate. 


Use this active-voice version instead: 


The Senate passed a bill. 


Putting the receiver of the verb’s action after the verb changes passive-voice writing into active voice. Passive voice 
is not ungrammatical, but it deadens, complicates, and lengthens writing. You use passive voice sparingly in 
everyday conversation, and you should use it sparingly in video productions. You are asking people to listen to your 
words. Focusing on active voice makes your copy more interesting and easier to understand. 


Using proven scriptwriting techniques 
The goal in video production is to tell stories. Scripts can help you plan and tell a coherent story. The following tips 
provided by two Hollywood scriptwriters, Stephen Black and Henry Stern, will help you construct your scripts: 


• Characters are important elements in stories: The best kind of character is one who can surprise you. The 
audience is not stupid. You need to come up with something unpredictable. You don’t want white hats or black 
hats. You want people wearing gray hats — people you can’t read. You want to be interested in what happens to 
them. 


• Start your script with a theme: Don’t start your scriptwriting with a plot; start with a theme. Know what you 
want to say, how you want to say it, and where you want to be at the end. The theme of our current film script is 
“How does the death of someone affect his three closest friends?” 


• Create characters: With the theme in hand, next create the characters. What is their arc and how will that change 
throughout the story? We invent detailed character bios. Where did they go to school? What were their parents 
like? What was their childhood like? We don’t have to use it all in the script, but knowing it helps craft the 
story. 


• Create story points: Make 30 to 40 story points, such as guy robs bank, hides in mother’s house, falls in love 
with neighbor, and so on. 


• Write an extensive narrative outline: This outline includes texture — the tone and detail — and describes 
settings and characters. Instead of merely using physical descriptions of characters, such as “Bob is 6 feet, 
2 inches tall with the torso of a long-distance runner,” we’re more likely to write, “As John was driving up 
Canyon Avenue, he looked out his rain-spattered window and caught sight of Bob, one more time, running in 
the rain.” Narrative makes the script easier to write. 


• Structure the story: It’s really crucial that you learn how to structure a piece so your story will make sense. 
Know where your story is going and how plot elements and character elements will build on one another so 
they peak at certain points. An excellent film example of structure is Two for the Road, with Audrey Hepburn 
and Albert Finney. Even though they use multiple flashbacks, you know that from beginning to end that this is a 
story of a marriage on the skids. 
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• Tell as much of the story as you can without dialog: Tell it cinematically. Don’t give camera directions such as 
wide, tight, medium. That’s the director’s job and disrupts the story flow. But it’s okay to script camera angles. 
We wrote a scene where a woman was about to tell her husband their son was killed in combat. The husband 
ran a steak house and happened to be in the walk-in freezer when his wife arrived. We directed the camera to 
look through the window and, without any dialog, show the woman tell her husband and watch his reaction. 


• Do the research: You can’t write if you’re not an observer. We’re constantly eavesdropping in restaurants. 
We’re acutely aware of dialog going on around us. Our characters have to speak in the vernacular of the time. 


• Use dialog: Dialog is more than just writing down what two people say to each other. Good dialog is succinct, 
crisp, entertaining, and rich. It’s a level above conversation. 


• Bury the pipe: The pipe is the exposition, the conduit of information, the stuff the audience needs to know to 
make sense of the story. This applies primarily to feature films and TV dramas. Say the character’s been 
divorced three times, has six kids with six different women, and runs a grocery. You don’t come out and say 
that. You impart it to the audience by revealing it gradually through dialog, action, and settings. 


• Make your scriptwriting collaborative: Everyone has a hand in it. A screenplay will go through multiple drafts 
before shooting begins. 


Mackie Morris, media consultant 
Mackie Morris is a journalism and communications seminar leader, teacher, coach, and practitioner. Previously, 
Morris served as chairman of the Broadcast News Department in the University of Missouri School of Journalism. 
He later worked as a vice president and lead consultant for Frank N. Magid Associates, a major media consulting 
firm, where he implemented a series of instructional workshops for broadcast professionals. 


Stephen Black and Henry Stern, scriptwriters and producers 
Stephen Black and Henry Stern have worked as scriptwriters for such episodic TV dramas as Dynasty, Falcon Crest, 
Flamingo Road, Matlock, and Knot’s Landing. Their work as head writers on As the World Turns and consultants 
for One Life to Live stirred things up and added sizzle to both of these long-running daytime staples. They’ve had a 
hand in a half-dozen TV movies, including the only TV film starring Audrey Hepburn, Love Among Thieves. 
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Shot list 
Name(s):  ____________________________________________________________________________________  


Project:  ______________________________________________________________________________________  
 


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  


 Shot  ______________________________________________________________________________________  


Location  ____________________________________  Talent  ______________________________________  


Props  ______________________________________  Special Equipment ____________________________  
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Student project proposal 
Name(s): _____________________________________________________________________________________  


Project title:  __________________________________________________________________________________  


Purpose:  _____________________________________________________________________________________  


Audience: ____________________________________________________________________________________  


Program length: _______________________________________________________________________________ 


Genre 
 Educational 
 Documentary 
 News broadcast 


 Kids’ video 
 Commercial 
 Game show 


 Foreign film 
 Drama 
 Action 


 Reality TV 
 Comedy 
 Music video 


 Video montage 


Elements 
 Interviews 
 Live action 
 Stage performance 


 Narration 
 Music 
 Special effects 


 Titles/subtitles 
 Graphics 
 Pixilation 


 VR 
 Video of pictures 
 Imported video 


 Composite


Equipment needed 
 DV camcorder 
 DV tape(s) 
 Tripod 


 Handheld mic 
 Lavaliere mic 
 Boom mic 


 DV-editing comp 
 External HD 
 TV/VCR 


 Lights 
 Reflector 
 Dolly 


 Chapstick/slate 
blue/green screen 


 Costumes:  _________________________________________________________________________________  


 Sets:  ______________________________________________________________________________________  


 Props:  ____________________________________________________________________________________  


Locations  ___________________________________________________________________________________  


 ____________________________________________________________________________________________  


Distribution 
format 


 
 DVD 
 MiniDV 
 Other: _____


 
 Hi8 
 Digital 8 


 
 CD 
 SWF 


 
 AVI 
 MOV 
 


Archiving: Archive up to 4.7 GB of computer files on Data DVD disk for future edits?     Yes     No 


Crew 


Producer/director:  ____________________________  


Scriptwriter:  _________________________________  


Camera operator:  _____________________________  


Editor:  ______________________________________  


Talent:  ______________________________________________________________________________________  
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Schedule of deliverables 


Final project due on:  __________________________  


Project phases Due date Owner 


   


   


   


   


   


   


   


   


   


   


   


   


   


   


   


   


   


Approved by:  ________________________________________________ Date:  _______________________  
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How to use the Audio Mixer to record a narration 
The Audio Mixer in Adobe Premiere Pro CS4 has several functions: 


• Record live narration and instruments. 


• Mix multiple tracks to create a pleasing audio blend. 


• Apply audio effects to an entire track. 


• Apply audio effects, volume control, and stereo panning to several tracks at once. 


This guide covers only the live-narration recording feature of the Audio Mixer. Later you will use the Audio Mixer 
to blend multiple tracks. 


How to record a narration 
The Adobe Premiere Pro Audio Mixer functions as a basic recording studio. It can record anything you can input 
into your computer’s soundcard. In this task, you use a mic plugged into that soundcard to do a voice recording. 


 


1. Connect the microphone to the mic-level input jack on 
the computer or sound card. 


2. Start Adobe Premiere Pro and start a new project or 
open a project with a sequence you want to narrate. 


3. Select Sequence > Add Tracks. 


 The Add Tracks dialog box appears (Figure 1). 


4. In the Audio Tracks area, Track Type menu, select 
Mono. 


5. In the Video Tracks area, change the Add: Video 
Track(s) setting to zero (it’s set to 1 by default) and click 
OK. 


 Note: If you have not changed the settings for the 
default sequence, your sequence will open with three 
stereo audio tracks and a stereo master track. The newly 
added mono narration track will be the fourth audio 
track and will have a single speaker icon, indicating it’s 
a monaural track. 


6. In the Timeline panel, drag the CTI to where you want 
your narration to begin. 


 Note: If you want to watch your video as you narrate it, 
set the CTI a few seconds ahead of the video (if there’s 
room in the sequence) to give you time to prepare before 
you start your narration. 


 
Figure 1 Add Tracks dialog box 
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Figure 2 Audio Mixer 


7. Select Window > Workspace > Audio and make sure the 
Audio Mixer tab is selected. 


 The Audio Mixer appears in the top center of the 
workspace (Figure 2). 


8. Expand the Audio Mixer width until you can see all the 
tracks you’re working with as well as the master track 
(it’s on the right side of the Audio Mixer). 


 The newly added mono narration track is just to the left 
of the master track. Because it’s monaural, it has only 
one channel (Figure 2). 


9. Change the narration track name in the top row of the 
Audio Mixer by highlighting the default track name 
(such as Audio 4) and typing Narration (Figure 2). 


10. In the Audio Mixer, click the Enable Track For 
Recording button (the microphone icon) for the 
narration track (Figure 3). 


11. Click the red Record button at the bottom of the audio 
mixer (Figure 4). 


 The Record button starts blinking. 


 


 
Figure 3 Audio Mixer track control buttons 


 


 
Figure 4 Audio Mixer Record button 
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12. In the Audio Mixer menu, select Meter Input(s) Only to 
meter only the sound card’s inputs (Figure 5). 


13. Test the input levels by speaking into the microphone. 


 Watch the VU meter for the selected audio track. The 
meter should move up and down as you speak. If 
nothing happens, check to see that your mic is connected 
and turned on and that the Windows or Mac OS audio 
controls have the mic input switched on. 


14. When you finish testing, deselect Meter Input(s) Only to 
meter the project’s other audio tracks also. 


15. To avoid feedback—that screeching noise that happens 
when a mic gets too close to a loudspeaker—either turn 
down the computer speakers, wear a headset, or click the 
Mute button (the speaker icon) in the Audio Mixer track 
(Figure 3). 


16. Click the Play button (Figure 6), and start your 
narration. 


 Note: The Play button becomes the Stop button. 


17. When you finish recording, click the Stop button. 


 An audio clip appears on the selected audio track in the 
Timeline panel and as a clip in the Project panel. Adobe 
Premiere Pro automatically names your clip based on 
the audio track number or name and adds the audio file 
to the project file folder on your hard drive. 


 
Figure 5 Audio Mixer menu 


 


 
Figure 6 Audio Mixer Play button 
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How to create TV news-style J- and L-cuts 
J-cuts and L-cuts, so named because the clip layout in a sequence look like the letters J and L, are effective editing 
techniques used frequently in TV news and feature films. They ease the transition from one clip to another. 


A J-cut starts by having the audio portion of a video clip (Clip B) play under another video clip (Clip A). After a few 
moments, the video portion of Clip A transitions to the video portion of Clip B and the audio of Clip B comes up 
full while the audio portion of Clip A fades away. This is a great way to let your audience know someone is about to 
say something or a transition is coming. Conversely, an L-cut has the audio of one clip tail off under the next video 
clip. This is an effective way to ease viewers out of a sound bite or narration track and into the cutaway. 


To do either of these edits requires unlinking the audio and video portions of clips that contain both audio and video 
so you can edit them separately. After you unlink them, you can move the audio segment to another audio track and 
then extend or shorten the audio portions of both adjacent clips to make the J- or L-cut. 


To complete the tasks in this guide, you should first work through the “How to adjust audio and apply crossfades” 
guide. That guide shows how to work with keyframes and adjust volume settings on audio clips in the Timeline 
panel, a prerequisite for creating J- and L-cuts. 


For these tasks, you need a video clip with sound, such as a narration video, sound bite, or similar clip and two 
cutaways (with natural sound). All the clips need enough head and tail frames to allow for some overlap and to make 
smooth transitions.  
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How to set up a J-cut edit 


1. Start Adobe Premiere Pro, start a new project, and 
import three clips that include both video and audio. 
Trim each clip at the heads and tails. 


 Note: This example uses one narration video and two 
short cutaways.   


2. From the Project panel, drag (in this order) a cutaway 
(with natural sound), the narration video clip, and 
another cutaway (or reuse the first one) to a sequence in 
the Timeline panel. 


 Your sequence should look like Figure 1. Your goal is 
to have the first cutaway video play over the first few 
words of the sound-bite audio and then have the video 
dissolve to the sound-bite clip while the cutaway audio 
fades out—a J-cut. 


3. Click the narration clip (or the middle clip) and select 
Clip > Unlink. 


4. Complete the unlink process by clicking outside the 
sound-bite clip in the Timeline panel to deselect it. 


 Note: Now when you click on either the audio or video 
portion of the unlinked clip, only the clicked portion is 
selected. 


5. Drag the unlinked audio portion of the sound-bite clip 
straight down to the Audio 2 track (Figure 2). 


 If there is no available audio track, simply drag the clip 
below the audio tracks and Adobe Premiere Pro will add 
an audio track that matches the format of your clip 
(mono, stereo, or 5.1 surround). 


 Note: Take care as you move the audio portions of clips 
that you don’t slide them left or right when you drag 
them. If you do, the audio and video will get out of 
synch. The timecode display should read +00;00;00;00 
to indicate the clip has not slipped. (Figure 2).  


6. In the Tools panel, select the Rolling Edit tool, click the 
video portion of the first clip (the cutaway) to select it, 
and drag the edit between the first and second video 
clips to the right about 1 second (Figure 3). 


 Use the timecode display to help make the edit. 


 Note: If you use the Rolling Edit tool with the narration 
clip selected, only the video portions of the narration 
and the cutaway clips move. 


7. Using the selection tool, drag the left edge (the in point) 
of the audio portion of the narration to the left to give it 
some extra room to fade it up. Be sure to move the in 
point and do not drag the clip out of sync. 


 The first two clips of your sequence should look like 
Figure 4. 


 
Figure 1 Three-clip sequence 


 


 
Figure 2 Dragging audio clip 


 


 
Figure 3 Rolling Edit and tool tip 


 


 
Figure 4 J-cut 
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How to add and adjust keyframes in a J-cut 
To make J- and L-cuts work effectively, you need to use keyframes in the audio clips to create something like an 
audio crossfade. 


You learned how to apply keyframes to a clip in the Timeline panel in the “How to adjust audio and apply 
crossfades” guide. Here’s a basic review: 


• Click the clip to select it. 


• Move the CTI to the point where you want to add the keyframe. 


• Click the Add/Remove Keyframe button in the audio track header. 


To adjust the value of the keyframe (in this case, the decibel level), drag the keyframe up or down and note the dB 
level in the tool tip. 
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1. Continue where you left off in the previous task. 


2. Expand the two audio tracks: 


• Click their Collapse/Expand Track triangles. 


• Drag the bottoms of their headers down. 


3. Use the Zoom In button in the lower-left corner of the 
Timeline panel to expand the width of the two clips. 


4. Apply five keyframes in the following locations in the 
audio clips (use Figure 5 as a reference): 


• First clip (the first cutaway) 


o At the point where the narration audio clip (the 
audio in track 2) begins. 


o Where the actual narration audio begins (use 
the beginning of the waveform in the narration 
clip to help find that spot). 


o At the end of the first cutaway clip. 


• Narration clip (the audio you moved to track 2) 


o At the beginning of the clip. 


o Just as the narration starts (use the beginning of 
the waveform to help find that spot). 


5. Adjust the keyframe values as follows:  


• First cutaway clip: Adjust the second keyframe to 
about –9 dB and the third keyframe down to 
negative infinity (silence) as shown in Figure 5. 


• Narration clip (in Audio 2 track): Adjust the first 
keyframe down to negative infinity (silence) as 
shown in Figure 5. 


6. Play the J-cut. 


 The cutaway’s natural sound should fade as the 
narration begins. 


7. In the Effects panel, open the Video Transitions > 
Dissolve bin and drag a Cross Dissolve video transition 
to the cut point between the two video clips to make this 
J-cut work even more smoothly. 


 
 
 
 


Figure 5 J-cut audio keyframes 


 


Waveform shows where 
narration audio begins 
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How to create an L-cut 


1. Continue where you left off in the previous task. 


2. Click the second cutaway and select Clip > Unlink. 


3. Click somewhere off the clip to complete the unlinking. 


4. Using the Selection tool, drag the in point of the audio 
portion of the second cutaway audio to the left, under 
the narration video (middle clip), about 2 seconds. 


5. Drag the out point of the audio portion of the narration 
clip to the right about 1 second. 


 As shown in Figure 6, the two audio clips should now 
overlap. 


6. Add six keyframes to the audio portions of the narration 
and second cutaway as follows (use Figure 7 as a 
guide): 


• Second cutaway (in Audio 1 track) 


o At the beginning of the clip. 


o A half-second into the clip. 


o A half-second or so before the end of the 
narration clip below it. 


o Directly after the narration audio ends (use the 
waveform). 


• Narration clip (in Audio 2 track) 


o Directly after the audio ends (use the 
waveform) 


o At the end of the clip. 


7. In the narration clip, drag the keyframe at the end of the 
clip all the way down to fade that narration audio under 
the cutaway. 


8. In the second cutaway, adjust the following keyframe 
values: 


• Drag the first keyframe all the way down. 


• Move the second and third keyframes to about 
-9 dB (to play the cutaway audio quietly under the 
narration). 


9. Add a video Cross Dissolve between the video portions 
of these two clips. 


10. Play the L-cut. 


 The second cutaway’s natural sound should fade up 
quietly beneath the narration’s closing comment and 
then climb to full volume as the video transitions from 
the narration to the second cutaway. 


 
Figure 6 L-cut audio set-up 


 


 
Figure 7 L-cut audio keyframes 
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How to use the Trim Monitor 
The Trim Monitor is a great way to do precise ripple and rolling edits. Its value is its large preview screens, detailed 
controls, and informative timecode displays. 


To complete this task, you need three video clips you can edit in a logical order. A sequence of matching shots 
works well. 


1. Start Adobe Premiere Pro, start a new project, and 
import three video clips. 


2. Drag the three clips to the sequence in the Timeline 
panel in a suitable order and adjacent to each other 
(Figure 1). 


3. Place the current-time indicator (CTI) at the cut line 
between the first and second clips. 


4. Check that the Video 1 track is targeted (the header is 
highlighted). 


 It should be targeted by default, but if not, click its 
header. You make this selection because the Trim 
Monitor displays clips on the targeted track. That’ll 
come into play more frequently when you start editing 
video clips on more than one video track. 


5. Click the Trim Monitor button in the lower-right corner 
of the Program Monitor (Figure 2). 


 The Trim Monitor opens with the out point of the first 
clip in the left preview screen and the in point of the 
second clip in the right preview screen (Figure 3). 


 
Figure 1 Three-clip sequence 


 


 
Figure 2 Program Monitor edit tools 


 
Figure 3 Trim Monitor 


Trim Monitor button 
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6. Hover the pointer over the left preview screen until it 
turns into a left-facing Ripple Edit tool. Drag the Ripple 
Edit tool left or right to create a new out point 
(Figure 4). 


7. Use the same ripple-edit method to trim the right clip’s 
in point. 


8. Click the Play Edit button (below the left preview 
screen) to review your work (Figure 5). 


 The edit plays once and then stops. 


9. Click the Go To Next Edit Point button (below the right 
preview screen—Figure 6). 


 The Timeline panel CTI jumps to the cut line between 
the second and third clips, and the Trim Monitor 
displays the out and in points of those two clips in the 
preview screens. 


10. Use the Ripple Edit tool to trim the out and in points of 
those two clips. 


11. Preview your edit by clicking the Loop button and then 
the Play Edit button (Figure 5). 


 The Play Edit button changes to the Stop button and the 
video plays. 


12. When you’ve seen the edit more than once, click the 
Stop button. 


13. Hover the pointer between the two preview screens. 


 It changes into the Rolling Edit tool (Figure 7). 


14. Drag the Rolling Edit tool left or right to change the out 
and in points of the left and right clips, respectively. 


 Note: As you make rolling and ripple edits, note how 
the Out Shift and In Shift timecodes change. In addition, 
look at the five timecode displays below the preview 
panes. From left to right, those numbers represent: 


• Outgoing clip duration 


• Outgoing clip out point 


• Edit point (cut line) position 


• Incoming clip in point 


• Incoming clip duration 


 


 
Figure 4 Ripple Edit tool 


 


 
Figure 5 Play Edit (left) and Loop buttons 


 


 
Figure 6 Go To Previous/Next Edit Point buttons 


 


 
Figure 7 Rolling Edit tool 
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15. Click the left preview screen to make it active. 


 A light-blue line appears below the screen. 


16. Use the precision trimming tools to move the left clip 
back and forward one frame—or five frames—at a time 
to fine-tune your edit (Figure 8). 


 You can do this with the right clip as well. 


17. Click Play Edit. 


18. Close the Trim Monitor by clicking the little ‘x’ on the 
right side of the tab. 


 
Figure 8 Precision trimming tools 
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How to edit with the Program Monitor 
The Program Monitor has two editing tools: lift and extract. These two editing methods are covered in the “How to 
work with clips in the Timeline panel” guide, which explains how to select a clip or group of clips in a sequence and 
lift or extract them from their position. 


The Program Monitor offers a slightly different approach to the Timeline panel lift and extract edits. Rather than 
removing a clip or group of clips, you can use the Program Monitor to remove a range of frames from the middle of 
a clip or across multiple clips on the same track.  


To complete this task, you need three video clips. 


1. Start Adobe Premiere Pro, start a new project, and 
import three video clips. 


2. Drag the clips to the sequence in the Timeline panel 
until they are adjacent to each other (Figure 1). 


3. In the Program Monitor, drag the right handle of the 
viewing area bar to the left to zoom in the time ruler 
(Figure 2). 


 Continue dragging until the time displayed at the right 
side of the time ruler (00;00;24;11 in Figure 2) is 
slightly more than the length of your sequence (the time 
code below the right side of the Program Monitor 
screen—00;00;22:11 in Figure 2). This will allow you 
to select edit points with greater precision. 


4. Drag the Program Monitor current-time indicator (CTI) 
within the first clip to a logical edit point. 


 Note: You can also drag the Timeline panel CTI to set 
the edit point. When you move one CTI, the other 
moves as well. 


 


 
Figure 1 Three-clip sequence 


 


 


 
Figure 2 Program Monitor time controls 


Viewing Area Bar handles          Sequence length 
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5. Click the Set In Point button (Figure 3). 


 A left-bracket with light-blue shading to the right of the 
bracket appears in the time ruler (Figure 4) and in the 
Timeline panel time ruler (Figure 5). 


 Note: The Program Monitor Set In Point and Set Out 
Point tools look like the ones in the Source Monitor and 
function the same way. 


6. Drag the Program Monitor CTI within the second clip 
and select an edit point. 


7. Press the Set Out Point button. 


 A right-bracket appears and the light blue shading falls 
between the in point and the out point in the Program 
Monitor and the Timeline panel (Figures 4 and 5). 


8. In the Program Monitor, click the Lift button (Figure 6). 


 You have deleted the selected frames from the sequence, 
leaving a gap in their place. 


 Note: The Lift and Extract buttons look the same until 
you get really close to the screen. As shown in Figure 6, 
Extract has tiny triangles indicating that adjacent clips 
will fill the gap left by the edit. 


9. Follow the methods in steps 4–7 to set in and out points 
in the second and third clips. 


10. In the Program Monitor, click the Extract button. 


 You have performed the equivalent of a ripple delete. 
An Extract edit in the Program Monitor removes the 
selected range of frames and then slides clips left to fill 
the gap. 


 


 


 


 
Figure 3 Program Monitor edit tools 


 


 
Figure 4 Program Monitor time ruler 


 


 
Figure 5 Timeline panel time ruler 


 


 
Figure 6 Program Monitor editing tools 
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How to adjust audio and apply crossfades 
Adobe Premiere Pro CS4 has tools you can use to decrease or increase the volume of an entire clip or parts of a clip. 
For example, you might want to bring the natural sound on a video clip down while you narrate, gradually fade up 
the audio at the start of a clip, or fade up an interview just as the narrator completes a segment. The latter technique 
is a J-cut that is covered in the “How to create TV news-style J- and L-cuts” guide. You can also apply crossfades—
audio transitions—between clips or at the end or beginning of a clip. 


You adjust audio volume levels in the Timeline panel, the Effect Controls panel, and the Audio Mixer. This guide 
covers adjusting audio in the Timeline and Effect Controls panels. This guide introduces keyframes. You use 
keyframes to set parameters for motion, effects, audio, and other properties, usually changing them over time. A 
keyframe marks the point where you specify a value. In this guide you use keyframes to set and change audio 
volume. When you use keyframes to create a change over time, you typically use at least two keyframes—one for 
the state at the beginning of the change and one for the state at the end of the change. 


To complete the tasks in this guide, you need two audio clips or video clips that have audio. What works best is two 
brief stereo music clips. 


How to use keyframes to adjust audio in the Timeline panel 


1. Start Adobe Premiere Pro, start a new project, and 
import the two clips needed for this project. 


2. Drag an audio (or audio/video) clip from the Project 
panel to the Audio 1 track in the Timeline panel. 


3. Check that the audio track view is in the expanded mode 
(the default condition when starting a new project). 


 If not, click the Collapse/Expand Track button 
(Figure 1). 


4. Expand the track height farther by moving the pointer to 
the bottom of the track header until it changes to the 
height adjustment tool and then dragging the bottom 
down until you can easily see the audio waveforms. 


5. Click the Show Keyframes button to display the 
keyframes menu (Figure 2) and make sure Show Clip 
Keyframes is selected—the default opening condition 
(Figure 2). 


6. Click the clip to select it and move the Timeline panel 
current-time indicator (CTI) to a point in the clip where 
you want to start changing the volume level. 


 


 
Figure 1 Audio track header 


 


 
Figure 2 Show Keyframes button and menu 
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7. With the clip selected, click the Add/Remove Keyframe 
button (Figure 3). 


 You have added a keyframe—indicated by a little 
diamond (it looks like a circle until you move the 
CTI)—at the CTI location on the audio volume 
keyframe graph (the thin horizontal yellow line) 
between the left and right channels in the audio clip 
(Figure 3). 


 Note: If you’re working with a monaural clip, there will 
be only one waveform and one channel displayed in the 
clip. If you have a 5.1 surround-sound clip, there will be 
six waveforms and channels. 


8. Move the CTI to a point where you want the audio level 
change to finish and click the Add/Remove Keyframe 
button to add another keyframe there (Figure 4). 


9. Hover the Selection tool over the second keyframe until 
the pointer changes to the Pen tool (Figure 4). 


10. Drag the keyframe up or down to increase or decrease 
the volume. 


 Note: A tool tip pops up briefly, telling you the 
timecode and the dB value (decibel or volume level) 
(Figure 4). Zero dB is the clip’s original volume level. 
Moving the volume graph to an exact dB setting later is 
difficult; you can use the Effect Controls panel Volume 
effect to do that.11. Drag the first keyframe to the 
beginning of the clip and drag the second keyframe to a 
point about 2 seconds into the clip. 


 Note: As you slide keyframes left or right, you 
invariably move them up or down a little, thereby 
changing their dB (volume) levels slightly. You can 
fine-tune the volume levels in the Effect Controls panel 
later. 


12. Create an audio fade-up by dragging the first keyframe 
down as far as it can go (the dB level will be negative 
infinity) and dragging the second keyframe to set its dB 
level to zero (Figure 5). 


 
Figure 3 Add/Remove Keyframe button and 
keyframe 


 


 
Figure 4 Audio volume keyframes 


 


 
Figure 5 Audio fade-up 
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How to adjust audio in the Effect Controls panel 


1. Continue where you left off in the previous task. 


2. Click the audio clip on the Audio 1 track to select it. 


3. Display the Effect Controls panel to view that clip’s 
Volume effect. 


4. Expand Volume to see the two Volume parameters 
(Figure 6). Expand the Level parameter. 


• Bypass: All audio effects have the Bypass feature 
(video effects do not). You can switch back to the 
default volume setting at any point in the clip by 
turning on Bypass. You can switch the effect off 
and on any number of times within the clip by using 
keyframes. 


• Level: Decibel (dB) level. By using keyframes, you 
can change the dB level as many times as you like 
within a clip. 


5. If the time ruler is not visible in the Effect Controls 
panel, click the Show/Hide Timeline View button 
(Figure 6). 


 Note: Widen the panel as much as you need to make the 
Show/Hide Timeline View button visible and active. 


6. Click the Go To Next Keyframe button (Figure 7). 


 Note: If the Go To Next or Previous Keyframe buttons 
are not active, there are no keyframes before or after the 
CTI.  You may need to move the CTI to see this. 


 The Effect Controls panel CTI moves to the second 
keyframe (small square icon) in the time ruler. 


7. Increase the Level to 2.0 for that volume keyframe by 
typing in a new value or dragging the Level slider 
(Figure 8). 


 The line graph to the right of the Volume Level slider 
moves up. 


8. Drag the CTI in the Effect Controls panel or the 
Timeline panel to about 2 seconds before the end of the 
audio clip. 


9. Click the Add/Remove Keyframe button. 


 You have added a keyframe to the volume line in the 
Effect Controls panel time ruler and to the audio volume 
keyframe graph in the clip in the Timeline panel. 


 Note: To remove a keyframe, move the CTI to the 
keyframe and click the Add/Remove Keyframe button. 


 


 
Figure 6 Effect Controls panel 
 


 


 


 
Figure 7 Effect Controls panel keyframe controls 


 


 
Figure 8 Volume Level controls 
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10. Move the CTI to the last frame of the clip by pressing 
the Page Down key and then the Left Arrow key. 


 Note: Page Down takes you to the first frame of the next 
clip or, in this case, because there is no next clip, one 
frame after the out point of the clip you’re working on. 
The Left Arrow key takes you back a single frame to the 
final frame of the previous clip. 


11. Drag the Volume Level slider as far to the left as it will 
go (to negative infinity). 


 Your clip’s volume keyframe graph in the Effect 
Controls panel should look something like Figure 9. 


 
Figure 9 Volume keyframe graph 


 


How to work with a crossfade audio transition 


1. Start where you left off in the previous task. 


2. Replace the clip on the sequence with two audio clips. 


3. Trim the out point of the first clip and the in point of the 
second clip to give them sufficient tail and head frames 
for a smooth transition. 


4. Click the Effects panel tab to display it. 


5. Open the Audio Transitions > Crossfade bin (in the 
Effects panel) and drag the Constant Power audio 
transition to the cut line between the two clips in the 
Timeline panel (Figure 10). 


6. Click the Constant Power transition o select it and view 
its parameters in the Effect Controls panel (Figure 11). 


7. Change the duration to 3 seconds. 


8. Listen to the audio crossfade. 


9. From the Effects bin, drag the Constant Gain audio 
transition to the Constant Power transition at the cut 
point between the two clips. 


 The Constant Gain transition replaces Constant Power. 


10. Listen to that transition. 


 Note: As shown in Figure 12, Constant Gain changes 
audio at a constant rate, in and out, as it transitions 
between clips. This can sometimes sound abrupt. 
Constant Power creates a smoother, more gradual 
transition. 


11. From the Effects bin, drag additional Constant Power 
transitions to the beginning of the first clip and the end 
of the second clip. 


 The two-clip sequence now has a nice audio fade-in and 
fade-out. 


 
Figure 10 Audio transition at cut line 


 


 
Figure 11 Effect Controls panel 


 


 
Figure 12 Audio transition graphs 
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Understanding the Titler 
The Titler in Adobe Premiere Pro CS4 is a multifaceted, feature-rich text-and-shape creation tool. You can use it to 
build text and two-dimensional geometric objects—of any size, color, or style—with borders, beveled edges, 
shadows, textures, and sheens. Titler-designed text and objects can be superimposed over video as static or rolling 
credits or used as stand-alone clips. Text and objects created in the Titler are called titles. 


This guide gives you a hands-on look at the basic text properties you can work with in the Adobe Premiere Pro 
Titler. After you complete this guide, you can learn how to create text and shapes for your projects in the “How to 
use the Titler to build text and objects” guide. In a later project you’ll work with extra features such as strokes (inner 
and outer borders), sheen, gradients, and rolling and crawling text. 


Before you move on to this guide’s task, here is a brief overview of the panels in the Titler (Figure 1): 


• Titler main panel: The screen and menus where you build and view text and graphics. The grayscale, 
checkerboard background denotes transparency. That is, if you place text or graphics created in the Titler on a 
video track above other video clips in a sequence, the video clips on lower numbered tracks will be visible 
wherever you see that checkerboard. 


• Title Properties: Text and graphic options such as font characteristics, strokes, and shadows. 


• Title Styles: Preset text styles. You can choose from dozens of styles or customize your own. 


• Title Actions: Align, center, or distribute text and groups of objects. 


• Title Tools: Define text boundaries, set text paths, and select geometric shapes. 


 


 


 
Figure 1 Titler 
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Examining text properties 


1. Start Adobe Premiere Pro and open any project. 


2. Select File > New > Title. 


 The New Title dialog box appears (Figure 2). 


3. Give your title a name and click OK. 


 The Titler appears (Figure 1). 


4. To create a text title, click the Type tool (the large T in 
the upper-left corner of the Title Tools panel—
Figure 3). 


5. Click anywhere inside the Titler main panel screen, type 
some text, press Enter (Windows) or Return (Mac OS), 
and type a second line of text. 


 You have two lines of text in a bounding box 
(Figure 4).  


6. Open the Font pop-up menu (at the top of the Titler 
main panel) and select a different font (Figure 5). 


 The text in the Titler main panel changes to the new 
font. 


 Note: If at any time, you inadvertently close a panel in 
the Titler, you can reopen it by clicking the Titler main 
panel menu (the triangle in the upper-right corner of the 
Titler main panel) and selecting the closed panel. 


 


 
Figure 2 New Title dialog box 


 


 
Figure 3 Type tool 


 


 
Figure 4 A two-line title 


 


 
Figure 5 Font menu 
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7. In the Properties area of the Title Properties panel, 
change the properties of the title as follows (Figure 6). 


• Click and hold on the Font Size number and drag 
left or right to select a new value or click the Font 
Size number to select it and then type a new value 


• In the same way, change the Aspect (below Font 
Size in the Properties area) to adjust the horizontal 
scale of the text so it expands (or shrinks) to fit 
within the width of the title-safe margin (Figure 1). 


 Note: NTSC TV sets cut off the edges of a video signal. 
Keeping text within the title-safe margin ensures that 
viewers will see all of your text. To display the title-safe 
margin, select Safe Title Margin in the Titler main panel 
menu. 


• Change the leading (below Aspect in the Properties 
area) to change the distance between the lines of 
type. 


• Change the Slant degree value to tilt the text left 
(negative value) or right. 


• Continue experimenting with the title properties to 
see the effects produced by each property.  


8. In the Title Actions panel, click the Vertical Center and 
Horizontal Center buttons (Figure 7). 


 Your text is now centered in the Titler main panel. 


9. In the Title Styles panel, click several styles in turn and 
notice how the appearance of your text changes. 


 Note: Styles are fonts with preset properties such as 
bold, italic, size, and slant, as well as effects such as 
stroke, sheen, shadow, fill color, and fill type. 


10. Close the Titler by clicking the little ‘x’ in the upper-
right corner (Windows) or upper-left corner (Mac OS). 


 Your newly created title appears as a clip in the Project 
panel (Figure 8). 


 Note: Adobe Premiere Pro saves your title in the project 
file. It does not show up as a separate file on your hard 
drive. 


11. To redisplay your title in the Titler, double-click it in the 
Project panel. 


 
Figure 6 Properties panel, Properties area  


 


 
Figure 7 Title Actions panel 


 


 
Figure 8 Project panel 
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12. To add the title to the current sequence, drag the title 
from the Project panel to a video track.  


 Note: To superimpose the title over another video clip, 
place the title in a video track above the current clip, 
such as Video 2 (Figure 9). You can view the result in 
the Program Monitor (Figure 10). 


  


 


 
Figure 9 Placing a title over another clip  


 


 
Figure 10 Placing a title over another clip  
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How to use the Titler to build text and objects 
You can use the Titler in Adobe Premiere Pro CS4 to create text and geometric objects. There are three methods to 
create text, each with horizontal or vertical text orientation: 


• Point text: Use the Type tool to create point text. Specify an insertion point to begin typing. As you type, a 
bounding box expands to accommodate the additional text. The text runs on one line until you press Enter 
(Windows) or Return (Mac OS) or select Word Wrap from the Title menu in the Main menu bar. Later, 
changing the shape and size of the bounding box correspondingly changes the shape and size of the text. 


• Paragraph text: Use the Area Type tool to set the size and shape of your text box and then type text. Paragraph 
text wraps automatically within the borders of the box. Changing the box size displays more or less text but 
does not change the shape or size of the text. 


• Path text: Use the Path Type tool to build a path for your text to follow by clicking points in the Titler main 
panel to create curves and adjusting the shape and direction of those curves. Then type text along that path. 


We recommend you complete the “Understanding the Titler” guide before working on the tasks in this guide. That 
guide explains all of the Titler panels and many of its properties in detail as preparation for this guide. 
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How to create point text 


1. Start Adobe Premiere Pro, start a new project, and 
import a video clip. 


2. Drag the clip to the Video 1 track in the Timeline panel. 


3. Select File > New > Title to display the New Title 
dialog box. 


4. Type a title name in the Name box and click OK. 


 The Titler appears. 


5. In the Title Styles panel (Figure 1), click a style that 
suits you. 


 Note: Later in this task you will change the style 
characteristics, which you can save as a customized 
style. 


6. In the Title Tools panel, click the Type tool, click 
anywhere in the Titler main panel, and type some text 
(Figure 2). 


 Note: The Type tool creates point text. Point text does 
not wrap. It continues off the screen to the right. 


7. To begin a new line of text, press Enter (Windows) or 
Return (Mac OS). 


8. To make the point text wrap when it reaches the title-
safe margin, choose Title > Word Wrap from the main 
menu. 


 Note: You can turn off the title-safe margin and action-
safe margin by opening the Titler menu (or selecting 
Title > View from the main menu) and then selecting 
either Safe Title Margin or Safe Action Margin. 


9. Click the Selection tool (the black arrow in the upper-
left corner of the Title Tools panel) and click to select 
the title text. 


 Handles appear on the text bounding box (Figure 3). 


10. Drag the corners and edges of the text bounding box and 
note how the text changes size and shape. 


 Note: Instead of dragging bounding-box handles to 
change text size, you can change values in the 
Transform area at the top of the Title Properties panel. 


 


 
Figure 1 Title Styles panel 


 


 
Figure 2 Title Tools panel 


 


 
Figure 3 Point text with bounding box 
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11. Hover the pointer just outside any handle of the text 
bounding box until you see the curved-line rotation 
pointer. Then drag the bounding box to rotate it out of 
its horizontal orientation (Figure 4). 


 Note: You can also do this action by using the Rotation 
tool (Figure 2). 


12. Edit the text by double-clicking with the Selection tool 
anywhere in the text and typing. 


 You can drag to select text you want to remove or 
replace. 


13. In the upper-right corner of the Titler main panel, click 
the Show Background Video button (Figure 5) to show 
the background video behind the title (Figure 6). 


 Note: Clicking this button toggles the background video 
on or off. Make sure in this instance, the background 
video is toggled on, as shown in Figure 6.    


14. Drag the Background Video Timecode (located below 
the Show Background Video button) to change to a 
different video frame. 


 Note: You can use the Show Background Video feature 
to help you position text or geometric objects over video 
clips. 


15. Delete the text by clicking the Selection tool, clicking 
the text in the Titler main panel (the bounding box and 
its handles appear around the text), and then pressing 
Delete. 


16. Click the Show Background Video button to switch off 
the display. 


17. Select the Vertical Type tool, click in the Titler main 
panel, and start typing (Figure 7). 


 Pressing Enter (Windows) or Return (Mac OS) places 
the second vertical column to the left of the first column. 
This is the default behavior because vertical text in 
parallel columns is principally used for Japanese text. 


18. Close the Titler window. 


 
Figure 4 Rotation pointer 


 


 
Figure 5 Show Background Video button 


 


 
Figure 6 Titler main panel 


 


 
Figure 7 Vertical point text 
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How to create paragraph text 


1. In the main menu bar, select Title > New Title. 


 The New Title dialog box appears. 


2. Type a title name in the Name box and click OK. 


3. In the Titler, click the Area Type tool (Figure 2). 


 The Area Type tool creates paragraph text. 


 Note: At any point in this or the following tasks, you 
can change the text style by clicking on a style in the 
Title Styles panel. 


4. In the Titler main panel, drag to create a text bounding 
box that nearly fills the title-safe margin. 


5. Start typing. Type enough characters to attempt to go 
beyond the right edge of the bounding box. 


 Paragraph text wraps at the bounding box borders and 
does not expand the bounding box you defined. To go 
down a line before hitting the right edge of the box, 
press Enter (Windows) or Return (Mac OS) (Figure 8). 


6. Click the Selection tool and drag the edges of the 
bounding box to change its size and shape. 


 Note: The text does not change size. Instead it adjusts its 
position on the bounding box baselines. If you make the 
box too small for all your text, the extra text scrolls 
below the bounding box’s bottom edge and a little plus 
(+) appears near the lower-right corner outside the 
bounding box (Figure 9). 


7. Close the Titler window. 


 
Figure 8 Paragraph text 


 


 
Figure 9 Marker indicating additional paragraph 
text is near the bounding box 
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How to put text on a path 
The Path Text tool is both elegant and tricky. You can use it to build paths that are simple or complex, straight or 
curved, for your text to follow. 


If you’ve worked with the Pen tool in Adobe Photoshop CS4, you know how to use the Path Text tool. Basically, 
you define a path by clicking a number of locations in the Titler main panel and dragging handles at each point to 
define the curves. 


 


1. In the main menu bar, select Title > New Title. 


 The New Title dialog box appears. 


2. Type a title name in the Name box and click OK. 


3. In the Titler, select the Path Type tool in the Title Tools 
panel (Figure 2). 


4. Drag diagonally anywhere in the Titler main panel. 


 That creates an anchor point with handles (Figure 10). 
You use those handles to define the curve’s 
characteristics. If you click without dragging the pointer, 
you won’t add handles. Adding them later is tricky. 


5. Drag somewhere else to create another anchor point 
with handles. 


 The Titler automatically creates a curved path between 
the anchor points (Figure 11). 


6. Add at least two more anchor points. 


 Each new point added outside the confines of the current 
bounding box expands the bounding box dimensions. 


7. Delete any point by selecting the Delete Anchor Point 
tool (Figure 12) and clicking an anchor point. 


 
Figure 10 Path text anchor point (center) and 
handles 


 


 
Figure 11 Path text anchor points and bounding 
box 


 


 


 
Figure 12 Path Type tools 
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8. Click the Pen tool, hover the pointer over any handle 
(the pointer changes to a black arrow), and drag the 
handle (Figure 13). 


 Make the path longer, shorter, or just move the path 
around to see how this tool works. 


9. Hover the Pen tool over an anchor point (the pointer 
changes to the same black arrow that appears over 
handles), and drag the anchor point to a new location to 
change the path’s shape. 


10. Click the Path Type tool again and then click anywhere 
inside the newly created bounding box but not on the 
path or anchor points. 


 A blinking insertion point appears at the beginning of 
the curved line. 


11. Type some text. 


 Your path text should look something like Figure 14. 


 
Figure 13 Pen tool on a handle 


 


 
Figure 14 Path text 


How to create shapes 
If you’ve created shapes in graphics-editing software such as Adobe Photoshop or Adobe Illustrator CS3, you know 
how to create geometric objects in the Adobe Premiere Pro Titler: you simply select from the various drawing tools 
in the Title Tools panel and drag to draw the shape. 


 


1. Continue where you left off in the previous task (with 
the Titler open). 


2. In the Main menu bar, select Title > New Title > Based 
On Current Title, or open a new title (File > New > 
Title). 


 The New Title dialog box appears. 


3. Type a title name in the Name box and click OK. 


4. In the Titler, click the Selection tool, marquee-select the 
text in the Titler main panel, and press Delete to create a 
clean slate. 


5. Select the Rectangle tool from the Title Tools panel 
(Figure 15) and drag in the Titler main panel to create a 
rectangle (Figure 16). 


 The rectangle has the characteristics of the style you 
choose in the Title Properties panel. The rectangle in 
Figure 16 has white solid fill and a shadow. 


 


 
Figure 15 Drawing tools 


 


 
Figure 16 Rectangle  
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6. In the Titler main panel, make a square by dragging 
while holding down the Shift key to constrain the 
shape’s aspect ratio. 


 Note: Using the Shift modifier key creates shapes with 
symmetrical properties: circles, squares, equilateral 
triangles, and arcs with right angles. To maintain the 
aspect ratio while resizing a shape you've already made, 
hold the Shift key before making the change. 


7. Click the Selection tool, marquee-select the two objects 
in the Titler main panel, and press Delete to make a 
clean slate. 


8. Select the Rounded Corner Rectangle tool and Alt-drag 
(Windows) or Option-drag (Mac OS) to draw from the 
center of the shape (Figure 17). 


 Using the modifier key makes the center remain in the 
spot where you first clicked. The object changes shape 
and size around that point as you drag the pointer. 


9. Select the Cropped Corner Rectangle tool. Hold down 
the Shift key and Alt-drag (Windows) or Option-drag 
(Mac OS) to constrain the aspect ratio and draw from 
the center (Figure 17). 


10. Select the Arc tool and drag diagonally across the corner 
points to flip the shape diagonally as you draw 
(Figure 17). 


11. Click the Wedge tool and drag across, up, or down to 
flip the shape horizontally or vertically as you draw 
(Figure 17). 


 Note: To flip a shape after you’ve drawn it, use the 
Selection tool to drag a corner handle in the direction 
you want it to flip. 


12. Use the Selection tool to marquee-select the objects you 
just created and press Delete to make another clean 
slate. 


13. Select the Line tool and drag to create a single line. 


 Note: To connect another segment to the line you just 
drew, attempt to click on the end point of the line. It’s an 
imprecise process. As shown in the next few steps, the 
Pen tool connects lines more elegantly. 


14. Select the Pen tool and click anywhere in the Titler main 
panel to create an anchor point that will become the end 
point of a line segment (don’t drag to create handles). 


 
Figure 17 Rounded rectangle, cropped-corner 
rectangle, arc, and wedge 
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15. Click again in the Titler main panel where you want the 
segment to end. (Shift-click to constrain the segment’s 
angle to multiples of 45°.) 


 This creates another anchor point, and a line segment 
appears between the two points. 


16. Continue clicking the Pen tool to create additional 
straight segments. 


17. Complete the path by doing one of the following: 


• To close the path, hover the Pen tool over the initial 
anchor point until a circle appears next to the Pen 
tool pointer (Figure 18). Click to make the 
connection. 


• To leave the path open, Ctrl-click (Windows) or 
Option-click (Mac OS) in the Titler main panel 
away from all objects and their bounding boxes. 


 
Figure 18 Closing a path 


 


 


18. Close the Titler window. 
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Peer review 
Name: _______________________________________________________ Date: ________________________  


Project: ______________________________________________________ 


Overview 
Revision is an important part of the design process. In addition to conducting review and redesign cycles personally 
and with your client, using peer review can also be beneficial to your project. Peer review occurs in many 
professional environments, and it is an essential skill to starting learning. 


When giving peer review, be sure to make both positive and negative points. Give critiques as suggestions, not 
commands. When receiving peer review, do not feel disenchanted or think you did a bad job based on one review. 
Every review is different and what one person may not approve, the next person may find exemplary. 


Process for presenting work for peer review 
• When presenting your work for peer review, state the purpose, audience, and goals of your video and point 


out any concerns you have. 


• When someone else presents work for you to review, your first response should be to reiterate their 
purpose, audience, and goals.  


• When the producer’s purpose, audience, and goals are clear, ask questions of the producer, make 
comments, and offer suggestions. 


• To conclude, have the producer summarize the suggestions and offer a plan for revision. 


Guidelines for giving comments and suggestions 
• Before making any comments, review the entire video and make sure you understand the producer’s 


intentions. 


• Point out the strengths as well as the weaknesses of the video (shot selection, writing, transitions, effects, 
and so on). 


• Offer suggestions, not commands. For instance, do not say “You should do this….” Instead, use “I” 
statements: “I see that…” or “I’m confused about....” 


• Be respectful and considerate of your peer’s feelings. Do not say or write anything you wouldn’t want to 
hear about yourself. There is no reason to be rude. 


• Make sure your comments are clear and specific so your peer knows what you are referring to. Give 
specific examples and point to video shooting techniques, editing techniques, script writing, and so on to 
make your point. (Comments such as “This is unclear” or “This is too vague” are too general to be helpful. 
Rather, make a comment such as “I’m confused by this clip because it seems out of place.”) 


• If you are writing your comments, reread them before giving them to your peer. Make sure your comments 
make sense and are easy to follow. 
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How to use the Adobe Media Encoder 
The Adobe Media Encoder converts sequences and clips into media suited for distribution on the web or on DVDs, 
iPods, cell phones, and other mobile devices. Here is an overview of the Adobe Media Encoder formats: 


• Audio Interchange File Format (AIFF): An audio file container format developed by Apple Computer, which is 
the standard audio file format used for storing sound data for Apple Macintosh and other electronic audio 
devices.  


• Microsoft AVI (AVI): Audio Video Interleave is a multimedia file format developed by Microsoft. AVI files can 
contain both audio and video data in a container that allows synchronous playback.  AVI files are easily played 
back on personal computers with Windows operating systems by using the Windows Media Player. 


• Windows Bitmap (BMP): The BMP file format, sometimes called bitmap or DIB file format (for device-
independent bitmap), is an image file format used to store bitmap digital images, especially on Microsoft 
Windows and OS/2 operating systems. The simplicity of the BMP file format and its widespread familiarity in 
Windows makes it a very common format for graphics programs that operating systems can read and write. 


• GIF: Graphics Interchange Format is a graphic image file format suitable for sharp-edged line art (such as 
logos) with a limited number of colors. This takes advantage of the format's lossless compression which 
preserves very sharp edges (in contrast to JPEG). 


• Animated GIF: A small animation based on successively displayed GIF images. Animated GIFs are the simplest 
form of animation and are supported natively by most browsers. Looping and minimal timing information can 
be set in an animated GIF, but complex animation is beyond this format's capabilities. 


• MP3: MPEG1 Audio Layer 3 is an audio file compression format with CD quality. MP3 is a standard file 
format on the Internet and many portable digital audio players. 


• P2 Movie: DVCPRO P2 (P2 is short form for "Professional Plug-In") is a professional digital video storage 
media format introduced by Panasonic. P2 is basically a professional video file format used for storing media on 
a data card for compatible tapeless recording devices.  


• QuickTime (MOV): QuickTime is a format developed by Apple Computer and is used for storing digital video, 
media clips, sound, text, animation, and music. QuickTime is the Apple multimedia architecture for HDTV and 
for web delivery as streaming media or for download.  


• Targa: TGA File Format, often referred to as TARGA File Format, is a raster graphics file format. The Targa 
format is used to create images in some video game programs. TARGA and VISTA boards were the first 
graphic cards for IBM-compatible PCs to support high color/true color display. This family of graphic cards 
was intended for professional computer image synthesis and video editing with PCs. For this reason, usual 
resolutions of TGA image files match those of the NTSC and PAL video formats. 


• TIFF: Tagged Image File Format is a file format for storing images, including photographs and line art. It is 
now under the control of Adobe Systems. Originally created by the company Aldus for use with what was then 
called "desktop publishing", the TIFF format is widely supported by image-manipulation applications, by 
publishing and page layout applications, by scanning, faxing, word processing, optical character recognition and 
other applications. 


• Uncompressed Microsoft AVI: See Microsoft AVI above. Exporting as uncompressed AVI will export the clip 
or sequence without applying additional compression to the output file. 


• Windows Waveform (WAV): WAV (or WAVE), short for Waveform audio format, is a Microsoft and IBM 
audio file format standard. Uncompressed WAV files are quite large in size, so, as file sharing over the Internet 
has become popular, the WAV format has declined in popularity. However, it is still a commonly used, 
relatively “pure”, i.e. lossless, file type, suitable for retaining “first generation” archived files of high quality, or 
use on a system where high fidelity sound is required and disk space is not restricted. 


• Audio Only (AAC): Compression for digital audio compatible with Apple iPod technology, designed to be the 
successor of the MP3 format. AAC generally achieves better sound quality than MP3. 
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• FLV | H4V (H.264): Adobe Flash Video, the format for delivering audio and video over the web and other 
networks. Adobe Flash Video will play on any computer with a Flash-enabled browser. 


• H.264: An MPEG-4-based standard for encoding for web delivery specifically and for a variety of devices, 
including HD video, 3GPP cell phones, video iPods, and PlayStation Portable (PSP) devices. The Adobe Media 
Encoder has H.264 format presets specifically for Google Video, MySpace, Yahoo! Video, and YouTube. 


• H.264 Blu-ray: An MPEG-4-based standard for encoding in HDTV for Blu-ray disc media. 


• MPEG1 and MPEG1-VCD (Windows only): A set of standards defined by the Motion Picture Experts Group 
(MPEG) designed to deliver video and associated audio at bit rates of about .5 to 1.5 Mbps (megabits per 
second). Video Compact Disc (VCD) videos play only on CDs. MPEG1 movies play on CDs and as 
progressively downloadable files on the web. 


• MPEG2: Delivers high-quality, full-screen, full-motion video at bit rates around 15 Mbps or about 10–30 times 
the data rate of MPEG1 or MPEG1-VCD. 


• MPEG2 Blu-ray: A subset of the MPEG-2 standard designed for encoding for high-definition (HD) Blu-ray 
Disc media. 


• MPEG2-DVD: A subset of the MPEG-2 standard designed for DVDs with a data rate up to 9 Mbps. An 
MPEG2-DVD file can be encoded directly onto a DVD to create a movie that plays automatically (known as an 
autoplay disc), or it can be used in an authoring program (such as Adobe Encore) to create a disc with 
navigational menus and other features. 


• MPEG2-SVCD: A variant of the MPEG-2 standard designed for the Super Video Compact Disc (SVCD) 
format. Up to an hour of relatively high-quality video can fit on a single CD. SVCDs can play on most set-top 
DVD players. 


• MPEG4: MPEG-4 absorbs many of the features of MPEG-1 and MPEG-2 and other related standards, adding 
new features such as extended support for 3D rendering, object-oriented composite files (including audio, video 
and VRML objects), support for externally-specified Digital Rights Management and various types of 
interactivity. 


• Windows Media (Windows only): A Microsoft multimedia architecture for HDTV, web delivery, and Palm 
devices. 


Each of these formats has many presets, so most editors will not need to adjust any parameters. However, there are 
numerous customizable options.  


For example, you may want to encode video for playback on mobile devices running Flash Lite. To do this you 
should first understand the specifications of the mobile device for which you are encoding the video. You can begin 
with a preset that most closely matches your specifications. You can then apply the necessary custom settings by 
opening the Export Settings dialog box and selecting custom settings on the Video and Audio tabs. Once you define 
the custom settings for a specific device, save these settings as a custom preset.  For Flash Lite, a good format to 
begin with is MPEG-4 3GP video and specify screen dimension to match the target devices, such as 240x240. 


You can also output video for Flash Lite on mobile devices from Adobe After Effects CS4 opening the composition, 
selecting File > Export > 3G… and selecting 3GPP (Mobile MP4) as the file format. 


To explain each format’s unique characteristics would go well beyond the scope of this guide. Instead, this guide 
shows you how to access the formats. The first task, “Overview of the Adobe Media Encoder,” has you select 
several different formats and then explains some concepts common to most of them. (For detailed explanations on 
each encoder, Adobe recommends that you visit the respective company’s website.) Then the guide gives a rundown 
of the specific steps you need to follow to use the Adobe Media Encoder to export a clip or sequence. 
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Figure 1 Export Settings dialog box  


Overview of the Adobe Media Encoder 


1. Start Adobe Premiere Pro and open a project with a 
sequence or clip you want to export. 


2. Select the sequence or clip in the Project panel, and then 
select File > Export > Media. 


 After a few seconds, the Adobe Media Encoder starts 
and the Export Settings dialog box appears.  


 Note: If the Adobe Media Encoder window is in front, 
bring the Export Settings dialog box to the foreground.  


 The export settings include a preview display on the left 
and tabs containing export settings on the right 
(Figure 1). The tabs display the settings that were used 
most recently. 


3. In the Export Settings area, select H.264 in the Format 
menu (Figure 2). 


4. Click the Output tab in the upper-left corner of the 
dialog box. 


 


 
Figure 2 Export Settings area menus 
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5. In the Preset menu, select 3GPP 176 x 144 15fps. 


• The image quality in the Output preview screen 
becomes blurry due to the small frame size of this 
preset. 


• The estimated file size is shown at the bottom of the 
dialog box (Figure 3). You will compare it to the 
file size of another format in the next step. 


6. In the Format menu, select MPEG2-DVD. 


 Note: The output image quality becomes very sharp and 
the estimated file size jumps to about 15 times the size 
of the low-resolution H.264 format. 


7. In the Format menu, select FLV | F4V (H.264). 


8. Open the Preset menu and look at the 20+ presets.  


 Figure 4 shows a few of those presets. 


9. Select FLV (Same As Source) Flash 9.2 And Higher. 


10. In the Export Settings area, view the Summary 
information (Figure 5). 


 This lists frame size and frame rate as well as audio and 
video encoder information. 


11. In the Format menu, select QuickTime. 


12. Click the Video tab, open the Video Codec menu, and 
select H.264 (Figure 6). 


 Note: H.264 is one of the formats in the Adobe Media 
Encoder. H.264 delivers video more efficiently than 
previous standards such as MPEG-2, and it’s built into 
the Apple QuickTime 7 multimedia architecture. 


 


 
Figure 3 Estimated File Size 


 


 
Figure 4 Adobe Flash Video Preset menu 
(segment) 


 


 
Figure 5 Export Settings Summary area 


 


 
Figure 6 Video tab Video Codec menu 
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 Note: Macintosh users, skip to step 15. 


13. In the Format menu, select Windows Media and verify 
that NTSC Source To Download 512kbps is the selected 
preset. 


14. Click the Video tab and view the basic video settings 
(Figure 7). 


 Note: Windows Media offers several encoding options: 
one or two passes, constant or variable bit rates, frame 
size, frame rate, and pixel aspect ratio. You can use 
these options to fine-tune the output. 


15. In the Format menu, select MPEG2-DVD and change 
the Preset to NTSC High Quality. 


16. In the Video panel, note the Quality slider (Figure 8). 


 Note: A high quality setting means the MPEG encoder 
will take longer to analyze the video before converting it 
to an MPEG-2 file. It does not affect the file size. 


17. Use the Video tab scroll bar to view the Bitrate Settings 
area. Increase the Target Bitrate setting and note that the 
estimated file size increases (Figure 9). 


 Note: Doubling the bit rate generally increases the 
MPEG-2 file size by about 50%. 


18. Click the Audio tab. 


19. In the Audio Format menu, select MPEG. 


 Note: PCM (Pulse Code Modulation) is the standard 
audio format for the Adobe Media Encoder MPEG2-
DVD format. It is a lossless format—it retains full audio 
quality. Dolby Digital compresses the audio but very 
little quality is lost in the process. After three trial uses, 
you need to pay to use the Dolby Digital encoder. 
MPEG also compresses the audio and yields high-
quality results. 


20. Scroll down to the Bitrate Settings area and select 
128 Kbps from the Bitrate menu (Figure 10). 


 The estimated file size drops considerably. Using MPEG 
audio encoding can lead to a slight audio quality loss, 
but you can increase the video bit-rate setting without 
exceeding the storage capacity of a DVD or the 9 Mbps 
DVD playback limit. 


21. To save a customized preset, click the Save Preset 
button located next to the Preset menu (Figure 11). 


22. Click Cancel to close the dialog box without saving the 
custom preset. 


23. Click the Output Name link to set a name and location 
for the output file (Figure 12). 


 
Figure 7 Windows Media Basic Video Settings  


 


 
Figure 8 MPEG2-DVD Quality setting 


 


 
Figure 9 MPEG2-DVD Bitrate Settings 


 


 
Figure 10 MPEG2 Audio Bitrate Settings area 


 


 
Figure 11 Save Preset button 


 


 
Figure 12 Output Name link 
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 The Save As dialog box appears (Figure 13). 


24. Navigate to a file folder, name the file, and click Save. 


25. Click OK in the Export Settings dialog box. 


26. Bring the Adobe Media Encoder window to the 
foreground. 


 Notice, the encoding process (Figure 14). When you 
first export the file, it begins in the waiting mode. It then 
moves on to the encoding step, and a green check mark 
indicates when the encoding process is complete. 


27. When the encoding is complete, close the Adobe Media 
Encoder. 


 


 
Figure 13 Save As dialog box  


 


 
Figure 14 Adobe Media Encoder progress  
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How to use the Adobe Media Encoder to export a sequence or clip 
You can use the Adobe Media Encoder to export a sequence, a sequence segment, a clip, or a portion of a clip. Refer 
to the “How to create standard image, movie, and audio files” guide for an explanation of how to prepare a portion 
of a clip or a sequence segment for export. 


 


1. Start Adobe Premiere Pro and open a project with a 
sequence or clip you want to export. 


2. Select the clip, clip segment, sequence, or sequence 
segment you want to export. 


3. Select File > Export > Media. 


4. In the Export Settings dialog box, specify the following 
options: 


• Format: Specify the media file format to be used by 
your intended audience. 


• Preset: Choose the option that most closely matches 
the specifications for the media to be viewed by 
your intended audience. As explained in the 
previous task, you can customize the settings by 
clicking on one of the tabs below the Export 
Settings area and changing the parameters there. 


• Export Video: Select this option to include video in 
the exported file; deselect this option to exclude 
video from the exported file. 


• Export Audio: Select this option to include audio in 
the exported file; deselect this option to exclude 
audio from the exported file.  


5. Click the Output Name link. 


 The Save File dialog box appears. 


6. Navigate to a file folder, name the file, and click Save. 


7. Click OK in the Export Settings dialog box. 


8. Bring the Adobe Media Encoder window to the 
foreground. 


 Notice, the file encoding progress. When you first 
export the file, it begins in the waiting mode. It then 
moves on to the encoding step, and a green check mark 
indicates when the encoding process is complete. 


9. When the encoding is complete, close the Adobe Media 
Encoder. 


 


 


 







Project 3 guide Adobe Premiere Pro CS4 


8 How to use the Adobe Media Encoder © 2008 Adobe Systems Incorporated 


How to use the Adobe Media Encoder to batch process media 
You can use the Adobe Media Encoder to encode multiple files at the same time. For example, you may be 
producing a series of short video or audio clips for use in a multimedia program. Instead of processing each file 
separately, you can add several files to the Adobe Media Encoder, select your settings once, and then process the 
entire batch of files.  


1. Start Adobe Media Encoder. 


 The Adobe Media Encoder window opens (Figure 15). 


2. Click the Add button 


 The Open dialog box appears. 


3. Navigate to the files you want to process. Select them, 
and click Open (Figure 16). 


 To select more than one file, hold down Ctrl (Windows) 
or Command (Mac OS) as you select the files. 


 Note: You can also drag files from an open window 
directly into the Adobe Media Encoder window. 


 Notice that the files you added are shown in the Adobe 
Media Encoder window (Figure 17). 


 


 
Figure 15 Adobe Media Encoder window  
 


 
Figure 16 Open dialog box  
 


 
Figure 17 A batch of files ready to process 
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4. Open the Format menu for the first file in the list and 
select a format to use for encoding (Figure 18). 


 The format you select is applied to the entire batch of 
files. 


5. Open the Preset menu for the first file and select a 
preset.  


 The same preset is applied to the entire batch of files 
(Figure 19).  


 Note: You can customize the settings by selecting Edit 
Export Settings on the Preset menu. 


 By default, the exported files will be placed in the same 
folders as the source file. You can change this location 
or rename the output files by clicking the links in the 
Output File column. 


6. Click Start Queue in the Adobe Media Encoder window. 


 The encoding process begins. The status column informs 
you when the encoding is complete by placing a green 
check mark beside each file. As the encoding occurs, the 
Media Encoder displays a progress indicator and shows 
a preview of the encoded file (Figure 20). 


7. When the files are encoded, close the Adobe Media 
Encoder. 


  


 
Figure 18 Format menu 
 


 
Figure 19 Format and preset applied to the batch 
 


 
Figure 20 Batch Encoding progress 


 









